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Block Filling

British-style puzzles, in which words are linked every alternate letter, have a 
regular pattern of blocks. You can quickly fill in the basic pattern by choosing 
Fill Blocks from the Pattern menu.

Block filling fills in every alternate block on alternate rows. There are four 
choices of starting position:

Fill from (1,1): Fill from (2,1):

Fill from (1,2): Fill from (2,2):

Note that fill from (2,1) and (1,2) is not compatible with dual-symmetry.



Symmetry

You can automatically create a symmetric pattern by selecting one of the 
symmetry options from the Pattern menu. You can have normal S-Symmetry
or Dual-Symmetry (Dual-Symmetry only works if you have a square puzzle).

This pattern shows Dual-Symmetry:

    

Whereas this one only has S-Symmetry:

    



Autofind

Use Autofind to find words to fit in the puzzle. Select Autofind from the 
Words menu, or click the right mouse button on a square in the word. Words
are found to fit in the current type direction, but if there is only one possible 
word through the cursor's square, words are found to fit there.

For example if you had a puzzle that looked like this:

You may want to find a word to fit down the middle. Click with the right 
mouse button on one of the squares, for example, above the 'D', to pop up a 
scrollable list of words that fit. Simply scroll through and select the word you 
want and press Insert. If you selected the word    ADMIRAL then the puzzle 
would look like this:

Note that compound words in the word list are not punctuated, e.g. 'OUT OF
DATE' appears as 'OUTOFDATE', as it will in the puzzle.

If not words are found that fit you can search the secondary word list. You 
can also toggle between the main and secondary word list by pressing the 
Other button on the Word Found dialog box. Change the word lists used as 
the main and secondary lists using the Word List Usage command on the 
Words menu.

To find a word to fit a given template use the Find Word... command on the 
Words menu. To find a fit for whole sections of the puzzle (rather than just 
one word at a time), use the Fill Automatically command on the Words 
menu.



Find Words

If you want to find words that match a specific pattern you can use the Find 
Word... command on the Words menu.

In the dialogue box enter the template for the word, using '?' for letters you 
don't know, or a '*'    for any number of unknown letters. E.g. to find a 5 letter
word that starts in 'T' and ends in 'ND' enter 'T??ND', and the program will 
find all the words in the lists which match (e.g. 'TREND'). To find all words 
starting with 'H'    and ending in 'K'    enter 'H*K'.

'*' can stand for any number of letters, including no letters. If you wish to 
find a word starting with an 'L'    ending in an 'N' at least two letters behind 
the 'L', you can enter '*L??*N'. This will find, for example, 'ALIEN' which has 
two letters between the 'L' and 'N', and 'ALLERGEN'    which has many letters 
between them. '*L*N' would include words like 'KILN' in the list, where the 'L' 
and 'N'    follow each other.

If you want to find words to fit in the puzzle it is easier to use the Autofind 
facility.

You can use '-'    instead of '?' if you like (it's a bit quicker to type).



Puzzle Flipping

You can flip a puzzle to its mirror image by selecting Flip Pattern from the 
Pattern menu. This has not effect other than the numbering and order of 
the clues, and the appearance of the puzzle. You can undo a flip by doing 
another flip. Here is a puzzle, one before and one after a flip:



Font

You may change the font used to display and print the puzzle and clues by 
selecting Font... from the Options menu. You can only use True Type fonts 
with Crossword Compiler. The point size you choose has no effect on the 
puzzle but is used in Printing the clues. Here is what a sample puzzle looks 
like with some of the standard fonts:

Arial: Arial Bold:

Courier New: Times New Roman:



Anagram

You can search for multiple word anagrams of a given word, either from the 
Clue Editor or by choosing Anagram... from the Words menu.

If you run it from the Clue Editor the word you are clueing will be 
anagrammed automatically. If you choose Anagram... from the menu you 
should enter the word in the dialogue box. If you wish to anagram for 
multiple words just enter the words you want to anagram.

Anagram finds all the multiple word anagrams of the given word up to a 
certain maximum number of component words. You can specify the 
maximum number of words in the Preferences dialog box. If you choose a 
large number the search is slower as there will be a lot of different 
anagrams. Specifying a small number also makes it easier to find a suitable 
anagram.

Anagrams are displayed as they are found. The words in multi-word 
anagrams are not sorted, but anagrams are found in order of word length, so
you should get all the straight anagrams before the multi-word ones.

You can abort the Search at any time by pressing OK. The program adds 
anagrams to the bottom of the list as it finds them. If there are a lot of 
possible anagrams they may not all be found, but you should always get at 
least the first thousand or so. The finder will work in the background as you 
edit other clues or whatever. To bring the window to the top just click on it. 
You can leave the anagram window open. It will be reset with a new word 
whenever you select Anag... in the clue editor, or New in the anagram 
window. Anag... sets the word to the word you are clueing, New prompts 
you for a new word to anagram.

Anagrams are found using the word file selected in the Anag files'    path 
and name input line in the    Word List Usage box. The program uses a list of 
words from 1 to 3 letters long for anagrams, specified at the bottom of the 
Word List Usage dialog box. This should contain the words in decreasing 
order of length, one word per line. It is best not to have very obscure short 
words otherwise the program will find very many obscure and meaningless 
anagrams. You should normally only change the default list of short words if 
you want to find anagrams in some other language.

The anagram feature is a quick and easy way to find anagrams of words. 
However if you wish to find meaningful anagrams of longer words, phrases or
names, it will take quite a long time. You may have to look through a list of 
16000 anagrams to find the best one!    There is however a dedicated 
anagram program that I can recommend to anyone with a special interest in 
anagrams, called Anagram Genius.





 Anagram Genius for the PC

 
    After six years of development what is probably the world's most    
sophisticated anagram generator has finally been ported to a    mass-market 
platform: Microsoft Windows.

    This highly unusual software takes the names of your friends, employers 
and competitors and transforms them in ways you would never believe. It 
rearranges the letters and uses powerful Artificial Intelligence techniques to 
say things that are weird, wonderful (and    sometimes extremely insulting!)

    For example: 
    
    ** type in "Ronald Wilson Reagan" and tell the software he is male, a 
politician and you want satirical anagrams. It rearranges the letters of his 
name to say he is "a long-insane Warlord"!
          
        ** You want to do some research into fundamental philosophy. Type in 
"The meaning of life" and out comes (along with many others) "The fine 
game of nil".

    ** Type in "The best things in life are free" and it produces "Nail-biting 
refreshes the feet": it is free after all (although you may need to pay for 
some yoga lessons first!)

    ** Type in "The end of the world is nigh!" and get "Down this hole, 
frightened".

    There are many many more examples, buy the software and you can add 
to them with (amongst others) your name, the names of your friends and 
colleagues, your employer, acquaintances, commercial rivals etc. Etc.

    (Thanks to Donald L. Holmes for finding the last two examples).

    Correspondence from existing owners of anagram genius

** Your latest version of Anagram Genius defies superlatives! What    a 
fantastic and fascinating creation!

** One friend turned out to be an anagram of "recombined anus", another 
"I'm a jolly anarchic poker" and my wife "And in herself weary"; all of which 
were appropriate. My yuppy boss found out her name was an anagram of 
"She'll engineer gain" which she thought appropriate.



** Terrific! It has brought me and my friends considerable entertainment.

** I was interested to note that an anagram of Virginia Bottomley "I'm an evil
Tory bigot" made it into the national press - I'd spotted that one a year earlier
using the original version of Anagram Genius! 

** May I congratulate you on an excellent product.

** There isn't anything I don't like about it ... I think you have a hit!

** It is much better and more sophisticated than I could imagine.

** The program is great and I am amazing my friends with it.

** Anagram Genius is wonderful.

... plus many many others.

(All quotes can be proven genuine on request. Some of the quotes refer to 
'Supergram', the name of the same software on the Acorn Archimedes. To 
avoid confusion 'Anagram Genius' was substituted into these examples.)

    Selected features of the latest version

** Choice between American or British English. The default is automatically 
selected from the computer's country code.

** 'Satire' flag for wildly satirical anagrams, 'Flattery' flag for flattering 
anagrams. 'Normal' flag for no good or bad bias.

** 'Vulgar words' flag allows on censors coarse or obscene language. (When 
not censored and combined with the 'Satire' flag these words are considered 
highly desirable!)

** Limit the number of anagrams to keep. Keep only anagrams scoring above
a certain score. Limit the number of words in the found anagrams.

** Describe the text by gender, political, computer or business associations. 
Describe the text in detail by specifying the relevance of individual words. 
Your description is used by the artificial intelligence routines to find relevant 
and meaningful anagrams for that subject.

** Include interjections, dropped 'H' words ("'ello", "'orrible" etc.) and others. 



Penalise anagrams for not being a good mix of the initial text.

** Automatic intelligent default punctuation and choice of word-order for 
each anagram which is completely overridable if you so choose.

** Print or save out reports, word lists and anagrams. Fully-featured print-
preview option.

** All anagrams are given a score and sorted into order. For texts which 
contain many anagrams you only need look at the best ones.

** The powerful back-end works hand-in-hand with an excellent user 
interface which is both logical and powerful. The process of finding anagrams
is divided into four conceptually clear stages. The stages can be flicked 
between and the computer's choices overridden or left as you choose. At all 
times you are in control.

** It can deal with short texts of just a few letters or long    texts of thirty 
letters or more which would choke any other software. Most texts are 
processed in just a few seconds but a powerful scheduling algorithm keeps 
the search within reasonable timescales no matter how massive its task.

*** All for just 19.99 pounds sterling! ***

    Anagram Genius ordering information

To run Anagram Genius you will need a machine running Windows 3.1 (or 
another compatible Operating System), 4Mb of RAM or more, at least 386 
processor and a mouse. The software is supplied on a high density 3.5" PC 
disc.

** All orders should be sent to:

                Genius 2000 Software
                Dept AL
                P.O. Box 395
                Cambridge CB3 9PJ
                United Kingdom

** In the United Kingdom: Send a cheque for 19.99 + 1.65 S&H (total 21.64 
pounds) payable to "Genius 2000 Software" to the above address. 

** In the United States: Send a check for $29.95 made payable to "Genius 
2000 Software" to the above address. Current airmail postage from the US to
the UK is 50 cents (write "airmail" on the envelope). Your order will be 
dispatched back to you by fast international airmail. This price includes 



shipping, handling, bank charges and all sales taxes.

** In other countries: send a cheque for 22.99 pounds sterling (19.99 + 3.00 
shipping and handling) drawn on a British bank to the above address. 
Alternatively add 5 pounds to cover bank charges (totalling 28.00), convert 
to your local currency and send a cheque in your native currency drawn on a 
local bank. All cheques should be payable to "Genius 2000 Software". 
Exchange rates are published in most newspapers.

These prices buy a single copy of the software and a licence to use it on one 
machine by one person at a time. If the software is to be used by more than 
one person you will probably need to buy a site licence: send email to 
AGenius@genius.demon.co.uk or write for details.

If you have any further questions please email: 
AGenius@genius.demon.co.uk



Changing Square Sizes

You can customise the size at which the puzzle and solution are displayed, 
printed, and copied to the clipboard. Select Square Sizes... from the 
Options menu to bring up a dialogue box.

Puzzle    - Specifies the size in millimetres of the puzzle used in printing and 
the suggested puzzle size when you copy it to the clipboard. 

Solution    - Size in millimetres of the solution.

Zoom % of puzzle size    - Specifies the factor by which the puzzle size is 
enlarged when you edit it on the screen. This does not effect the printed size.



 Editing the Puzzle

When you start a New puzzle, or Open an existing one, the puzzle is 
displayed in the window with a cursor in the top left hand corner.

You enter letters from the current cursor position by typing as normal. Insert 
black squares (blocks) by pressing the space bar. In the puzzle there are 
usually words going in two directions; to change the direction of typing press 
tab, or click on the direction icon on the Toolbar. This then displays the 
current type direction. The cursor also changes to show the type direction:

          To type Horizontally

          To type Vertically

You can use the cursors to move round the puzzle, or click with the left 
mouse button to move to a certain square. You can also insert blocks by 
double clicking with the left mouse button.

For a full list of keyboard commands see Keyboard.

You can fill in some of the pattern by using the Fill Blocks command on the 
Pattern menu.

To automatically insert blocks in symmetrical positions select one of the 
Symmetry options on the Pattern  menu.

You can create irregular puzzles by removing unwanted squares from the 
puzzle. Press Ctrl+Delete with the cursor on the square to be removed. To 
remove all blank squares from the puzzle, select the Remove Blanks 
command from the Pattern  menu. This makes the puzzle only have lines 
around squares with letters or blocks in, so giving it an irregular outline.

 You can Undo editing by pressing Alt + Backspace. This moves the cursor to
the end of the last editing action and then undoes the action. You can repeat 
undo a large number of times to undo whole chunks of the puzzle (in the full 
licensed version). Undo does not remove interlocking letters, so your 
intersecting words are left intact. Undo is particularly useful with Autofind to 
test words in certain positions and then undo them if necessary.



Printing Headers

Select Headers... from the File menu to specify headers that you can be 
print when you Print a puzzle.

Every time you print a crossword you can print Left and Right headers at the 
top of the page. You can also have a centred header below the left and right 
headers. Leave a header box blank to leave that header position blank. If you
have no right header the left headers covers the entire top of the page, if 
you do have a right header the left header covers at most the left half of the 
page. You can check the Justify Right box if you want the right header to be 
right justified.

Save headers to use the same headers every time you start the program.

You may customise headers to provide constant text (such as your name and
address) or variable data (such as puzzle details or date).To supply constant 
text, simply type that text in one of the header boxes. To supply variable 
text, use one or more of these control codes each beginning with a '%' (you 
can use upper or lower case).

%D Day of the month %W Puzzle width
%M Month of the year %H Puzzle height
%Y Year (abbreviated. E.g. 95) %N Number of words in 

puzzle
%F Puzzle's file name %P Puzzle's path and 

filename
%R Puzzle's reference %Rn nth line of the puzzle 

reference

Some examples:

What you want the header be What you type

12 x 15 puzzle: 21 words %W x %H puzzle: %N words
Antony Lewis 10/5/96 Antony Lewis %D/%M/%Y
File Name: DEMOPUZ.CWD File Name:%F

Codes are particularly useful in conjunction with puzzle References - if you 
standardise your references so that, say, the first line is a puzzle title, you 
can create a header for puzzles in the form

 DEMO PUZZLE by Antony Lewis

by using the header text '%R1 by Antony Lewis'. You then never need to alter
the Headers when you make new puzzles - you just have to write the 



reference and the header will be automatically changed.

By default the entire reference is printed as the left header - just '%R'.



Giving the puzzle a reference

You can give a reference to a puzzle in addition to its file name by selecting 
Reference... from the File menu. Enter anything you want, typically 
information about who wrote the puzzle, when, etc. It has no effect other 
than to give some extra information about the puzzle. You can be print the 
reference as part of a header when you Print the puzzle.



Copying to the clipboard

You can copy the puzzle, clues, solution or answers to the clipboard to use 
them in other Windows programs. Select Copy to Clipboard from the file 
menu, and select what you want copied from the submenu.

 The puzzle and solution are copied as pictures (metafiles) that can be 
resized in the host application. They are copied by default at the size 
specified in the Square Sizes dialogue box, but can then be resized without 
any loss in quality.

    The clues and answers are copied as Rich Text Format (RTF) and plain text. 
The host application will use the appropriate format. Most word processors 
(but NOT Write) and DTP programs will accept RTF, which gives formatted 
text, bold clue numbers right aligned, etc. Other programs can use the plain 
text, but it won't look as good. 

    You can customise the space between clues and the space between the 
clue number and clue in the Format dialogue box when using RTF. You can 
also change the relative size of the numbers in the puzzle. You can set the 
font used in the puzzle and solution in the Font dialogue box. The host 
program sets the font for the clues and answers. This ensures that it will 
match whatever font you are using in the other program. 

If you find that the clues do not copy correctly then try increasing the 
Number/Clue space in the format dialog box. When you copy clues to the 
clipboard you are prompted to include clue format information: that is, do 
you want the clue length in brackets after every clue.

The answers option copies the answers in text form, e.g.

Across: 1 Cueing, 4 Abbott, 9 Infant prodigy, 10 Connoisseurs, 12 Alcove, 
14 Shinto, 16 Overdecorate, 19 Command module, 20 Donate, 21 Oyster.
Down: 1 Chitchat, 2 Elfin, 3 Non-conversant, 5 Biotechnology, 6 Omicron, 7
Toys, 8 Spasm, 11 Forebear, 13 Cavemen, 15 Bendy, 17 Adult, 18 Scud. 

The solution option copies the completed puzzle, as it looks when you edit it, 
eg.

      

You can put the clues and answers into columns or whatever you like in the 



host program.



Reviewing the Clues

    You can view the clues written so far using the Review Clues... command 
in the Clue menu. The clues are shown in two scrollable lists, with the clue 
number at the left, and the solution to the right. If a word is unclued the clue 
reads 'No Clue'. If    there are incomplete words in the puzzle the solution 
appears with question marks for the missing letters. 

      You can edit a clue by selecting the clue by scrolling through the lists and 
pressing the Edit button (Alt+E), or double clicking on the clue with the left 
mouse button. This brings up the Clue Editor dialogue box which you can 
then use normally. You can move between the Across and Down clues using 
Tab and Shift+Tab.

It is a good idea to review the clues before you Print them to check you 
haven't missed any clues, or that any words are incomplete. It also makes 
quite a convenient way to edit the clues.



Keyboard

Keyboard controls when editing puzzle:

CURSORS Move the cursor

CTRL+CURSORS Skip to next or previous word start

TAB Toggle type direction

ENTER Move to left or top of next line

SPACEBAR Insert Block

DELETE Delete letter/block at cursor

CTRL+DELETE Remove square from puzzle

SHIFT+DELETE Delete word. Doesn't effect intersecting words

ALT+BACKSPACE Undo

ALT+A Autofind 

ALT+E Edit Clue 

F1 Help Index

F2 Save

CTRL+ESC Switch to another program

See Mouse for mouse combinations and the Toolbar topic



Mouse

Left Button Move cursor to square clicked on

Double Left Button Insert block in square clicked on

Right Button Autofind words to fit in word clicked on

See Keyboard for keyboard shortcuts, and the Toolbar topic.



Open an existing file

    You can open an existing crossword file by selecting Open... from the File 
menu.
Enter the name of the file to open, or select the directory and file from the 
list boxes and press Open. If you have an unsaved puzzle already open you 
will be prompted to save it before opening the new puzzle.

Crossword Compiler puzzle files have the .CWD extension, and are in a 
special format, you cannot open files saved by another application.



Starting a new crossword

    You can start a new crossword with a blank grid by selecting New from the 
File menu.
You are prompted for the size of the puzzle you want to create. Valid sizes 
are between 3 and 39 squares in height and width. If you have an unsaved 
puzzle already open you will be prompted to save it.



Saving a puzzle with a name

You can give a puzzle a name, or save under a new name by selecting Save 
As... from the File menu. Enter the name for the puzzle and press OK. You 
can select a different directory by using the list box on the right.
 
You can save the puzzle as a .CWD file for further editing with Crossword 
Compiler, or as Rich Text Format, to use in other applications. Change the 
selection in the Save file as type input box to change the setting and give 
the file a name ending in '.RTF'. You cannot open puzzles saved as Rich Text 
Format (RTF) from Crossword Compiler. You can however use RTF to save the 
puzzle, clues, etc. so that you can use them in word processing and DTP 
programs. If you save as RTF you are prompted for what you want saved in 
the file, the puzzle, clues, solution, answers or a combination. If you check 
the Skip clue format info box, the clues are copied without the length in 
brackets after each clue.

You can save a puzzle as a .CWD file with its present name by pressing F2 or 
selecting Save from the File menu.



Save

Select Save from the file menu or press F2 to save the puzzle with its 
present name. If the puzzle is un-named the Save As dialogue box will open 
for you to choose a name.



Printer Setup

Select Printer Setup... from the File menu to select and setup a printer for 
Printing. Select the printer you want from the drop down list. You can press 
the Setup... button to set other options such as page orientation, size etc.



Toolbar

The toolbar is the array of icons at the to of the program window. By clicking 
on them with the mouse you can quickly invoke the command they 
represent. You can hold the mouse cursor over a button for a short time to 
pop up a hint which tells you what the button does. Use this feature if you 
are unsure what any button does. 

Here is a complete description of all the buttons:

      Get Help

Open an existing file

Save the crossword

    Invoke Autofind 

Fill Automatically from cursor

Toggle type direction 

Undo last change. Can be used 
multiple times.

Edit Clue

See Editing the Puzzle for more information on undoing    and type directions.



Writing Clues

To edit the clue for a particular word in a puzzle press Alt+E with the cursor 
on the word for the clue you want to edit. You can also use the Edit tool on 
the Toolbar. If there are two words through the letter at the cursor, it will 
select the word in the current type direction. A dialog box will pop up in 
which you enter the clue. Once you have finished the clue press Enter to 
close the dialog box, or Alt+> to edit the next clue. The clue number is 
displayed in the title bar of the dialog box and the clue word is displayed 
below that. There is a large input box for entering the clue and an input line 
for entering the format of the word.

Here's a summary of clue dialog box commands. You can also call most of    
them by clicking with the mouse on the buttons at the top of the dialog box:

 Enter Close editor, saving changes
 ESC Close editor without saving changes
 Alt+D Delete the clue
 Alt+> Move to next clue, saving changes
 Alt+< Move to previous clue, saving changes
 Alt+K Link the clue
 Alt+A Find Anagrams
 Alt+P Paste in clue from the Clue Database
 Alt+L Display list of    Letter Indicators
 Alt+I Display list of    Anagram Indicators
 F1 Bring up this help screen
 
I suggest that you complete the puzzle network before starting to write 
clues. You can then systematically write each clue in order so there's no 
chance of missing a clue or writing a clue for a word that you will change 
later. Once you have finished you can review the clues by selecting Review 
Clues from the Clue menu.

 Editing the Clue

To edit the clue, or write a new one, simply type the clue in the Clue editor 
box. The editor word-wraps the clue as you type. The clue will be correctly 
word-wrapped when you print it as well. The clue can be of any length up to 
a maximum of 400 characters, which should be long enough for anyone's 
purposes. You can move the cursor within the editor box by using the cursor 
keys, or by clicking with the mouse. You can skip to the next word using Ctrl-
Right or the last word with Ctrl-Left.

You can change the format of the solution by entering the format in the Word
Format input line.





 Word Format - Automatic Word length

Do not include the length of the clue in the clue editor, but in the Word 
Format input line. By default this is just the number of letters in the word, 
which is entered automatically. However if the 'word' is hyphenated, or more 
than one word, you can enter the format here. Just type the number of 
letters in each word, or hyphened half word, and a comma to indicate a new 
word or a hyphen to indicate a hyphen. The format is then automatically 
included in brackets at the end of the clue you print it. The word is also 
correctly formatted in the dialog box and when you print the answers.
For example if the word is displayed as ONTOPOFTHEWORLD (On top of the 
world), then type '2,3,2,3,5' in the format line. On pressing tab the correctly 
formatted word will appear at the top of the dialog box. If the clue is linked 
then enter the format for the linked solution.



 Printing the Crossword

Select Print... from the File menu to print the crossword. A dialog box is 
displayed showing the various print options. Check the check boxes for what 
you want printed. 'Puzzle' just prints the blank numbered puzzle as it would 
appear in a newspaper. You can also print the solution with the words.
 
You can choose to print just the clues, in which case they are printed word 
wrapped in two columns, or you can print the clues with answers - word 
wrapped clue on the left and the solutions on the right (as when you review 
the clues).

You can check the Skip clue format info box to suppress the usual automatic 
word length feature. Using Dithered Blocks can be useful if you want to 
speed up printing on a dot-matrix, or stop the paper getting soggy on an 
InkJet.

You can disable Headers by un-checking the Print Headers box. If you haven't
specified any headers then none will be printed anyway. By default the 
header is just the puzzle reference.

If you try to print the clues before you have written them the program will 
print out the clue numbers with a blank space next to it. This is useful if you 
like to work to a hard copy when writing clues. You can then type in the clues
when you are satisfied with them.

Note that very large puzzles may not fit on A4 paper. You will be asked 
whether the square sizes should be shrunk to make it fit if the puzzle doesn't 
fit. To change the margins choose the Page Setup... command    from the File
menu. You can change the printer by selecting Printer Setup... on the File 
menu.

Printing the puzzle uses all the settings set in the various Options dialog 
boxes.
See Square Sizes , Font and    Format for more information.



Word List Usage

Select Word List Usage... from the Words menu to set and change the 
word file directory settings. Click on the Set button by the one of the lists' 
directories to change it. Select the word file that you want to use and press 
OK. Word files have a '.X7' extension in the file box, just select one of these, 
the entire list will be used.

Autofind uses the main word list to search for words. If no words are found in 
that list then the secondary list, if it is not the same, is scanned. This allows 
you to specify a specialised word list as the main list, and a general word list 
as the secondary list. This is useful for creating subject specific crosswords, 
as often the specialised word list will not be big enough to find words to fit in 
all the spaces. You can also scan the shorter SHORTS word list (which 
contains few obscure words and endings), and then to search the more 
comprehensive WORDS list if few matches are found.

By default the SHORTS.X?? word list is used for Automatic Filling, as it 
contains less obscure words, and far fewer parts of speech than the WORDS 
word list. If AutoFill cannot fill in a section using the specified word list, it will 
prompt to see if you want to try doing a fill from the secondary word list.



Preferences

Select Preferences... from the Options menu to change various program 
settings.

You can disable ToolTips for the ToolBar by deselecting    the check box. You 
can also make backup files. If you select this option a file with the '.BAK'    
extension will be created whenever you save a puzzle. This helps to prevent 
disaster if you accidentally delete the crossword file, or make some change 
that you later decide was unnecessary.

You can also change the default puzzle size.

The maximum number of words found by Autofind can also be altered. 
Specifying a very large number may slow down the search considerably, and 
a huge list of words is not very helpful. Suggested numbers are in the range 
of hundreds or a couple of thousands. Specifying a small number would 
probably only increase the search speed significantly on a very slow 
computer. Larger figures are recommended as you can then scroll through 
the list so that your puzzle does not end up with all its words beginning with 
'A'.

You can change the maximum number of words in multi-word anagrams 
found by the Anagram facility. Numbers larger than 3 or 4 will tend to make 
the search slow and produce vast numbers of anagrams for long words.

Settings in the Preferences... box are saved automatically to your currently
selected configuration file when you quit the program.



Linking Clues

It is possible that you have two or more words in the crossword for which you
wish to write a combined clue. For example, if somewhere in the puzzle there
are the two words PREGNANT and PAUSE you may wish to write one clue for 
the phrase 'PREGNANT PAUSE' rather than two separate clues. To do this 
bring up the Clue Editor with the cursor on the word 'PREGNANT'. Press 
Alt+L, or click with the mouse on the Link button at the top of the dialog 
box. Enter the number(s) of the clues to link to (the number of the clue is 
displayed at the top of the dialog box when you edit the clue). In the 
example above, 'PREGNANT' may for example be 1 Across, and 'PAUSE' 5 
Across. To link the two simply enter '5' in the input line and press Enter. The 
word at the top of the editor dialog box will now be PREGNANTPAUSE, and to 
format this correctly you should enter '8,5' in the Word Format    input line. 

From now on these two words will be linked, and if you select Edit Clue with 
the cursor on 'PAUSE' it will automatically show you the clue you have 
written for 'PREGNANT PAUSE'. If you Print the puzzle 5 Across will have the 
clue 'See 1', and 1 Across will have the linked clue. If you print the answers 
the linked word will be printed after 1 Across and not after 5 Across. If at 
some point you change the puzzle layout so that 'PAUSE' is no longer 5 
Across but, say, 7 Across, the linking will still be done correctly.

You can link more than two words by entering the clue numbers you want 
linked separated by '/'. Do not enter the number of the clue you are editing, 
but just the clues you want linked to the end of it. You must be editing the 
first clue in the link so that you get the words linked in the correct order. You 
can only link words in the same direction. To try to link clues that are already 
linked would be an error as you can only link a given word once.

Note that pressing OK in the Link dialog box saves the clue as it is when you 
close the box. The link will not be undone if you Cancel the clue editor box 
after making a link. To remove a link bring up the Link dialog box and press 
delete to clear the input line. There will then be no links, and the clues of the 
words that were linked will be returned to the state they were in before the 
link was made.



Ordering Crossword Compiler

This program is distributed as Shareware. You may use the program for a 
maximum of 30 days for evaluation. If you wish to use the program after this 
period you must order a licensed copy. The program costs only £28 including 
P&P for EEC, and £30 for other countries. An order form is provided and can 
be printed out by pressing the Order form... button when at the program 
start-up screen, entering your details and printing the form. 

Otherwise send a cheque, Eurocheque or PO/International Money Order to

        Antony Lewis, 16 Townley Rd, London SE22 8SR, England.

You can order by credit card over the internet: see 
http://www.wp.com/netword.

If you would like more information or have some questions you can also e-
mail to ccw@netword.demon.co.uk or visit the web pages at 
http://www.wp.com/netword.

I can accept cheques made out in any convertible currency. Please calculate 
what £32 comes to in your local currency and make out a cheque for that 
amount (the extra £4 is to cover the bank charge for accepting foreign 
cheques). If you would like to order word lists as well then please add £6 for 
each word list you want before converting.

Licensed uses get the full version of the program, with word lists for 3 to 20 
letters, including compound words. The licensed version also has facilities for
adding and removing words from the word lists, and manipulating word lists. 
It comes with an installation program to set it all up for you.

I also have a program called WordWeb Pro, a powerful thesaurus/dictionary, 
which can be used as a separate program or from Crossword Compiler. It 
costs jsut £15 inclusive.

You may also buy some additional word list disks at £6 each.

The sets are as follows:

Disk 1 - Medical, legal, ethnic, names, food, US places, UK places, cities, 
literature, Old Testament, RAF, IATA, Olympic, school chemistry, 
174000+ unusual words and variant spellings. 

Disk 2 -  233000+ Words from Webster's second edition, 75000+ 
Expressions from Webster's second.



Disk 3 - 156000+ German, 131000+ French, 85000+ Spanish, 60000+ 
Italian.

Disk 4 - 270000+ Finnish, 61000+ Norwegian, 24000+ Danish, 11000+ 
Swedish.

UK Advanced Cryptics Dictionary v1.3



Ordering Crossword Compiler in N. America

This program is distributed as Shareware. You may use the program for a 
maximum of 30 days for evaluation, if you wish to use the program after this 
period you must order a licensed copy. 

You can order the following:

Full licensed version of Crossword Compiler for $45
Two disks of additional word lists for $25
WordWeb Pro, a comprehensive thesaurus/dictionary, for $25

Toll Free Ordering:    Visa and MasterCard orders may be placed by calling Laser Point at 
(800) 894-6758.

Electronic Mail Registration:    You may register via electronic mail by sending the following 
information to orders@laserpoint.com

- Name of the product you are registering
- Visa or MasterCard Account Number
- Card Type (Visa or MasterCard)
- Card Expiration Date
- Name of card holder

Postal Mail Registration:    You may send cash or checks, drawn in U.S. funds on a U.S. bank, 
to:

Laser Point
Crossword Compiler Registration
P.O. Box 2378
Watsonville, CA 95077
USA

CompuServe:    CompuServe customers may wish to use the CompuServe Shareware 
Registry.    GO SWREG and register product ID 11407.

Licensed users get the full program, with all features enabled and word lists 
from 3 to 20 letters. The licensed version also has facilities for adding and 
removing words from the word lists, and combining word lists. It comes with 
an installation program to set it all up for you.

The additional word disks include the following lists:

174000+ Unusual words and variant spellings 
233000+ Words from Webster's second edition 
75000+ Expressions from Webster's second 
medical, legal, names, ethno, literature, Old Testament, US places, 
UK places, cities, IATA, RAF, Olympic and food and drink



 Format

    You can change the layout of the puzzle and clues when printed or copied 
to the clipboard by selecting Format... from the  Options menu.

Spacings

These specify the gap left between the number of the clue and the clue 
itself, and the vertical space between different clues when printed or copied. 
If you have problems copying clues to the clipboard, or opening a file save as
Rich Text Format you could try increasing the value of the number/clue 
space. Some programs don't like small measurements.

Size % of Squares

Here you can change the relative size of the squares and the numbers, the 
letters and the lines. Give a value in terms of the percentage of the Square 
Size. These ratios will then be preserved if you change the square sizes, or 
change the size once copied into another application.

Across/Down

Enter the text you want to head the across and down clues here. This setting 
is used when the clues are printed or exported. You could change the default 
settings to, for example, 'ACROSS'    and 'DOWN'    to use capitals, or a foreign
translation of 'across'    and 'down'    to use with non-English puzzles.

Print Clues in Roman

Check this box to print the clues in Times New Roman font, regardless of the 
setting in the Font dialog box. Otherwise the same font is used for the clues 
as for the puzzle.

All changes in this box are saved automatically when you quit the program.
See Page Setup for changing the margins.



Information

For statistics and file information about a crossword select the 
Information... item on the File menu.

Labels in box are self explanatory.



Removing Blanks

To remove all squares in the puzzle with no letter or block in, select the 
Remove Blanks  item on the Pattern menu.

Removing blanks gives the puzzle an outline that goes round every filled 
square, allowing you to create free-form puzzles. You can toggle a square 
between being removed and blank by pressing ctrl+delete with the cursor on
the square. Here is an example of a puzzle before and after removing the 
blanks:

Clear Letters

Select Clear Letters from the Pattern menu to clear all the letters in the 
grid leaving a blank grid. If you have written some clues for the words you 
are clearing you will be prompted to delete all the clues as well. If you 
choose to clear the clues they will be lost for ever, however you can replace 
the letters you cleared by using the undo button on the Toolbar.

You can use Clear Letters to extract a blank grid from a puzzle you or 
someone else has already written, saving you the trouble of creating a new 
grid.



Page Setup

Select Page Setup... from the File menu to change the margins used when 
the puzzle is printed.

All measurements are in centimetres.



Filling the Puzzle Automatically

 You can fill in complete puzzles, or sections of puzzles from a word list using 
the Fill Automatically command on the Words menu. You can also click on 
the AutoFill icon in the Toolbar.

 AutoFill attempts to fill in all non-complete words connected with the word 
the cursor is in. Place the cursor in a square in the section you want to fill, or 
place it in a blank square at the top of the grid to fill a blank puzzle. You need
to have your array of black squares finalised before invoking AutoFill, which 
then fills round the blocks you have.

For example, if you had a crossword that looked like this:

you could place the cursor next to the 'E' in 'STICKER', and invoke AutoFill, to 
get a complete crossword. For example

Where there is a choice of words that will fit, one is chosen at random. You 
may be able to produce many different fits by pressing Alt+Backspace to 
undo one fill, and then invoking AutoFill again,

    AutoFill uses the word files specified in the AutoFill    files' path and 
name input line in the Word List Usage dialog box. By default, if you installed
for British English, this is the SHORTS word list, which is much shorter than 
the full WORDS word list. It contains words    likely to be acceptable in any 
British crossword. If you installed for American English the default is the 
WORDS word list which is much larger. You need to use a large word list to 
successfully in fill American style grids.

While the computer is searching, words that it is trying are shown in the 
puzzle. The program actually looks 1 to 2 levels deeper than is displayed, but
it gives you some idea    of the progress that it is making. You can cancel or 
stop the search at any time by pressing the buttons on the pop-up dialog 



box. There is a beep when the search is complete.



Clue databases

Clue databases allow you to database clues from puzzles that you have 
written, or to store your flashes of inspiration until the word comes up in a 
crossword. You can open a clue database, or create a new one, by selecting 
Open Database... item on the Clue menu. 

You can add clues from puzzles to the database using the Add clues from 
puzzle command, or by adding new clues using the Add clue to database 
or Browse Clues... command. 

You can paste clues from the database when editing a clue by selecting the 
Paste... button at the top of the clue editor. A box pops up showing all the 
clues in the database for that word. You need not paste in the clue, you could
use the facility to check that your clue is sufficiently different from the 
previous clues that you have written. If there are no clues in the currently 
selected database the Paste button is disabled. This gives you a quick means
of telling whether there are clues in the database or not.

 You can merge databases together using the Merge Databases... command, 
including ones that were not created using Crossword Compiler. This should 
save you from re-entering all the clues if you already have a database on 
computer.

Crossword Compiler clue database files have the .CDB extension, and are in 
the format of
keyword in capitals, space, then the clue. Each entry like this is on a 
separate line.



Creating new word lists

To create a new word list select the Make New List... option from the    
Words menu. Select the directory you want and type in a name for the new 
list. Press OK when done. You will be prompted to make to new list the main 
word list. You will probably wish to do this as you will then be able to add 
some words to the empty word list. See the Changing Word Lists topic



Merging word lists

Select Merge File... or UnMerge file... from the Main Word List sub-menu
of the Words menu to add or remove an entire file of words from the main 
word list. The words will be added or removed from the main word list 
currently selected in the Word List Usage dialog box. You can merge in either 
merge files (one word on each line), or Crossword Compiler word files. For 
the purpose of choosing the file to add the word files are shown with a '.X7' 
extension. This is just for illustration, the entire word list will be (un)merged 
in if you select one .X7 file. 

Merge files to add must be in the format of one word per line. The words in 
the file can be punctuated, out of order and in upper or lower case. If the 
word file you want to merge in was created using DOS and contains non-
English characters, you should run the DOSTOWIN.EXE program in the 
Crossword Compiler root directory. You can then merge in the file correctly as
long as your computer is set up in the same way as when the word list was 
created.

Only words that are not already present will be added, so avoiding double 
entries. If you are adding a very large file of words, be prepared to have a 
coffee while you wait - it may take some time. A count of the number of 
words added or removed is given when finished.



Browsing clues

You can browse the clues in the currently select clue database by selecting 
Browse Clues... from the Clue menu. Type a word in the input line and 
press 'enter' to display all clues in the database for that word. Double click 
on a clue to edit it, or select it and press Delete to delete it. You can add new
clues by pressing the New button. When you have finished browsing press 
OK to save the changes, or cancel not to save. Saving may take several 
seconds if you have a large database, please be patient! 

See the    Clue Databases topic for more information on clue databases. 



Configuration Files

The program saves your current configuration every time you close the 
program. You can specify a different configuration file by selecting 
Configuration File... from the Options menu. To open an existing 
configuration file just type the name. 

To create a new configuration file enter a name for the new file. You will be 
prompted to create a Program Manager icon for each configuration file that 
you make. You can then start Crossword Compiler with a particular 
configuration by clicking on the relevant icon in the Program Manager. 

The program will save settings in whichever configuration file is selected 
when you close the program. You will also be prompted to save the 
configuration whenever you change configuration files.

Multiple configuration files can be useful if you create crosswords matching 
widely different specifications. For example, if you create a specialised 
crossword on some topic, but also general crosswords, you would probably 
wish to use different word lists for the two. You may also wish to set the font, 
size, format etc. differently if you are going to use the puzzles in different 
ways. By saving each set-up in a different configuration file you can easily 
switch between the two.



Merging clue databases

You can merge clue databases together by using the Merge Databases... 
command. Just select a database to merge into the currently selected one. If 
the database you are merging in was not created by Crossword Compiler you
should check that the database is in the following format:

      WORD Clue after a space

Each clue should be on a separate line, and they must be in strict 
alphabetical order. You cannot merge in non-Crossword Compiler databases if
they contain non English characters in the databased words.



Adding a clue to the database

To add a clue to the current clue database select the Add clue to 
database... option on the Clue menu. Type in the word and then the clue 
and format just as you would when editing a clue. Press Add to add the clue 
to the database. To add all the clues from a puzzle use the Add clue from 
puzzle command on the same menu. You can browse, delete, add and edit 
clues in the database by selecting the Browse Clues... command.    See the 
Clue Databases topic for more information on clue databases.      



Desktop Publishing

 Crossword Compiler for Windows has various features to help you DTP your 
crosswords. To use them in another application that you run, they can be    
Copied to the Clipboard  and pasted into the host application.
 
If you wish to save your crosswords so that other people can use them in 
their publisher programs then save the puzzle as Rich Text Format (see    
Saving). This is the best way of transferring puzzles, clues etc. between 
Windows based systems. However if you want the puzzle to be used in a 
Macintosh publishing program you may be better off saving the puzzle and 
solution as an EPS file. Macintosh should have no problem with Rich Text 
Format clues and answers, but some programs cannot always use the puzzle 
and solution reliably.

To print puzzles and solutions as EPS files (encapsulated PostScript) for non-
Windows publishers:

1. Install a PostScript printer driver, i.e. one for a HP LaserJet PostScript 
printer. If you use a PostScript printer or already have this installed anyway 
then go to step 3.

2. To Install the driver run the Print Manager (in the Main program group). 
Select Options Printer Setup... from the menu. Click on Add>> button. Select
HP LaserJet 3 PostScript. Click on Install... You will need your original 
Windows disk 2 at this point. If you use Windows 95+, this may be slightly 
different, see the manual.

3. Using CCW select Printer Setup from the File menu. Select the LaserJet 
printer. Click on the Setup... button. Click on the Options button. Select Print 
to Encapsulated PostScript file and enter a file name. Keep pressing OK to 
close all the dialog boxes.

4. Select Print and print the Puzzle or the Solution (un-check the Print 
Headers box). The puzzle or solution will be printed to the file.



WordWeb Pro

WordWeb is a comprehensive thesaurus/dictionary for Windows that can be 
used directly from Crossword Compiler. You can run it as a separate program,
or call it from the Clue Editor to paste in words.

In addition to displaying sense definitions and synonyms, WordWeb can also 
find sets of related words including

      Antonyms - Words opposite in meaning, e.g. bright/dull
      Hypernyms - More general, less specific words, e.g. jungle/forest 
      Hyponyms - More specific words, e.g. forest/jungle 
      Meronyms - Words which denote a part or member, e.g. tree/forest
      Holonyms - Words which denote a collection, eg. forest/tree

WordWeb allows you to filter the synonyms found by sense and by part of 
speach.

The database used by WordWeb contains many words for which there are no 
synonyms, in which case the sense description gives you detail about what 
the word means.

WordWeb matches case of synonyms, e.g. search for "pulpits" and WordWeb 
finds "podia", "rostra", "ambos", etc, search for "pulpit" and you will get the 
singular synonyms.

It comes with a 100000+ word list containing only words in the WordWeb 
database which can be used for word finding and grid filling when used with 
Crossword Compiler.

WordWeb also comes with a template for MS Word v6/7 which allows you to 
integrate it into the Word environment. There are also macros to let you use 
it from Ami Pro, Word Pro and Word 2.

There is a FreeWare version of WordWeb which cannot be used directly from 
Crossword Compiler. If you have the Freeware version you can upgrade to 
WordWeb Pro at a reduced price (you only need one disk instead of three) - 
see the WordWeb help file for more information.

WordWeb Pro is supplied in both Windows 3.1 and Windows 95 editions. 

If you have any questions or would llike more information please E-Mail 
WordWeb@netword.demon.co.uk.
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Introduction to Cryptics

Cryptic clues are very popular in Britain, and have a following in North America. In cryptics, 
unlike 'quick' or American crosswords, the clue has a cryptic part in addition to a definition 
part. This makes them harder to solve, but    there should be no ambiguity about whether 
an answer is correct or not. The cryptic part of the clue consists of some instructions on 
how to put together the answer from its letters, a play on words,    or some other quirkiness.
Here is an explanation of some of the more common clue types, though in practice many 
clues will be a combination of these simple types:

Double Definition

Here the clue consists of two parts, both of which are synonyms or definitions of the word. 
E.g.

    Calling charge (6)      

=CAREER, calling (meaning job) and charge (as in to charge round)    both mean career, 
though not in the meaning first implied by the clue.

Likewise 

 Money-lust (3) = YEN Cook fish (3) = FRY 

Anagram

This consists of two parts, an anagram of the word and a definition. Often the anagram is 
indicated by some Anagram Indicator, meaning 'mixed up', 'shuffled' or whatever. E.g.

    Platter to cook waffle (6)

=PRATTLE, anagram of 'platter', meaning to waffle. 'To cook'    indicates the anagram, 
though more properly 'to cook'    would be before the anagram. However misplacing of the 
indicator, or complete omission of the indicator are quite common.
Likewise

 Rioted to get control of news! (6)

 = EDITOR, an anagram of    'rioted' . The anagram indicator here is 'rioted' , which is also 
the word to be anagrammed, hence the exclamation mark which usually indicates some 
overlap in the clue.

Reversal clues are special cases of anagram clues, where the anagram happens to be just 
the word backwards. In this case it would be indicated by some word such as 'back' or 
'rising'.

Hidden Word

Here you can find the word in the middle of the clue. It is normally indicated by some word 
like 'inside'. E.g.



 Uncover a veneer, inside is black (5)

=RAVEN, meaning black. The word is hidden in 'UncoveR A VENeer' .

Homophone

This is where the cryptic part of the clue leads to a word that is pronounced the same as 
the answer but spelled differently. It is usually indicated by some word or phrase like 'we 
hear' or 'reportedly'. E.g.

 Heard the branch bend (3)

=BOW, meaning 'bend', a homophone of 'bough' (meaning 'branch'). These type of clues 
can turn into more of a pun, where the clue is followed by a question mark:

    Poem heard from soprano pigeon? (5)

=HAIKU, a Japanese poem, pronounced roughly as 'high-coo'.

Charade

The clue spells out the parts of the word. E.g.

 Failed English dandy (4)

=DUDE, meaning dandy. Failed=DUD, English=E (this is a standard letter indicator for the 
letter E), hence DUD+E=DUDE.

Often these have more than two parts.

Container

The clue instructs you to place some letters inside others, producing the word. E.g.

 Complain when club admits the French (5)

=BLEAT, meaning complain. Club=BAT, the French=LE (using foreign words like this is 
another standard strick), admit 'LE' to the middle of 'BAT' and you get 'BLEAT'.

? clues

The '?' is used to indicate some pun or weirdness in the clue. It can be used on almost any 
clue that doesn't follow the usual forms of clue. E.g.

 Meeting needed to make pear juice? (5,10)

=PRESS CONFERENCE, you need to press conference pears in order to make pear juice.



 Park? (6,4)

=COMMON NOUN, 'park' can mean a common, and is also a common noun. 

It is used in 'backwards clues', where the answer to the clue could be a clue itself, e.g.

    Wot, wot ?(3,4)

= TWO FOLD, if you take 'two'    and 'fold'    it you get 'wot' . 'Wot' occurs two fold in the 
clue. Likewise

    Draw? (8)

=BACKWARD, 'draw' ='ward'    back(wards). These clues do not have a definition part. This 
is usually only acceptable if the clue has some other particular merit.

'!'    clues

Like the '?' , the exclamation mark is sometimes used to indicate something unusual. 
However usually it indicates some overlap in the clue, where say the word to be 
anagrammed also forms part of the definition. An example is

    It's in hearing! (3)

=EAR, 'ear'    occurs in 'hEARing'    and if you are in hearing your ear certainly is!

The exclamation mark is also used very occasionally in ultra-short clues, e.g.

    L! (4,3) = TAIL END or J!(4,5) = JUMP START

The clues lack any definition part, and the '!'    could equally well be replaced by a question 
mark.

Indirect Anagram

These clues are like anagram clues except that the anagram is not given explicitly and 
must be deduced from a synonym or whatever. This type of clue is very difficult unless the 
word is very short, and is frowned upon in many circles. E.g.

    Find hole in tangled string (4)

=PORE, meaning 'hole', an anagram of 'rope' which is itself a synonym of 'string'    

    Must go round garden (4)

=NEED, anagram of 'EDEN' , a garden.

Others



There are numerous other varieties of clue, most of which are used in special crosswords 
where the solver is told about the type of clue used. For example in misprint clues, where a 
part of the clue has been misspelled,    the misspelling must be corrected before the clue 
can be solved. E.g. the definition part of the clue may be 'harp', but it would appear in the 
clue as 'hard'. This makes everything much trickier!



Crossword Jargon

Here are some definitions of words that crop up in crossword literature. They are not used 
in the documentation of Crossword Compiler or WordWeb, so you don't need to learn them!

Cruciverbalism Wordsmithism

Light A word in a puzzle which is to be clued

Unch A letter in a light that does not intersect    with another 
light

&Lit A cryptic clue where the entire clue is also a 'literal'    
definition of the light.



Anagram Indicators

A
aberrant abnormal abnormally
absurd accident about
accommodated accommodation accidental
adaptation adapted adapt
addled adjust addle
adrift adversely adjusted
affected afflict affect
afresh after a fashion afflicted
agitated agitator agitate
all at sea all over the place aimless
alter altered all wrong
alternatively amalgam alternative
ambiguous ambiguously amalgamate
amiss amok amended
anomalous another anew
anyhow anyway another way
arising from around appear
arranged arrangement arrange
assembled assembly askew
astray at fault assorted
at sea at sixes and sevens at odds
awful awfully at variance
awkwardly awry awkward

B
badly baffled battered
beaten up become becomes
becoming befuddled bend
bends bent bewildered
bizarre blend blending
blended blunder botched
break break down break out
break up breaking breaks
brew brewed broadcast
broke broken broken down
broken up buckle buckles
buckled buckling build
builder builders building
built bungled bust
busted by accident by arrangement
by mistake

C
calamitous calamitously can be



capricious capriciously careless
carelessly catastrophic catastrophically
causes cavort cavorted
cavorting change changeable
changed chaos chaotic
chaotically characters chew up
chewed up chop up chopped up
churn circling circulated
clarify clumsy cocktail
collapse collapsed combination
come to come to be come to grief
comes to comic comical
complicated components compose
composed composer composition
compound comprise comprised
comprises comprising concealing
concoct concocted concoction
confounded confuse confused
confusion constituents constitution
construct constructed construction
contort contorted contraption
contrariwise contrary contrivance
contrived conversion convert
converted convertible converts
convulse cook cooked
correct corrected correction
corrupt corrupted corruption
could be cracked crack up
cracked up crash crashed
crazily crazy create
creation crooked crude
crumbled crumbling crumple
crumpled crush crushed
cunning cunningly curious
curiously

D
damage damaged dance
danced dealt with deception
decomposed defected defective
deformed deformity demented
demolished demolition deplorably
deployed derange deranged
derivation derivative derived from
design designed destroyed
devastated devastation develop



developer development deviant
deviating deviation devious
deviously devised dicky
different differently difficult
dilapidated disarranged disarray
disaster disastrous discomposed
disclose disconcerted discord
discordance discordant disfigured
disfigurement disguise disguised
dishevelled disintegrated disintegration
dislocate dislocated dislocation
dismantled disorder disordered
disorderly disorganisation disorganise
disorganised disoriented dispersal
disperse dispersed disposed
disposition disquieted disrupted
disruption dissembling disseminated
dissipated dissonance dissonant
distorted distortion distracted
distractedly distraught distressed
distributed disturb disturbance
disturbed dithering divergence
divergent diversification diversified
divert diverted dizzy
doctor doctored doddery
dotty doubtful doubtfully
dreadful dreadfully dressed
drunk drunken drunkenly
dubious dubiously dud

E
eccentric effect effected
effects embody embroil
emend emendation emended
engendering engineered enough for
ensemble entangled entanglement
equivocal erratic erratically
erring erroneous error
erupting eruption essentials
exceptional exceptionally excited
exotic exploded explosion
extraordinarily

F
fabricate fabricated fabrication
failing failure fallacious
false falsely falsified
faltering fanciful fantastic



fashion fashioned fashioning
faulty fermented fickle
fiddle figuring in find
fixed flaw flawed
flounder fluctuating fluctuation
flummoxed flurried fluster
flustered foolish foolishly
for a change forced forged
form of forms formulating
fracas fractured fracturing
fragments freakish free
freely frenzied fresh
frisky frolic frolicking
from fudge function
funnily funny funny looking
fused

G
garbled generating get
get-up get face-lift gets
gets face-lift give rise to gives
gives rise to gives go amok
go astray go bad go berserk
go off go straight go to pieces
go to pot go to the dogs go wrong
goes goes off gone off
grotesque gyrate gyrates
gyrated

H
haphazard hapless harassed
hash havoc haywire
helter-skelter hide higgledy-piggledy
hidden hopeless horrible
horribly hotchpotch hybrid

I
idly ill ill-disposed
ill-formed ill-made ill-treated
ill-used impaired imperfect
improper in in a bad way
in a fashion in a ferment in a frenzy
in a heap in a jumble in a knot
in a mess in a muddle in a riot
in a tangle in a tizzy in a tumult
in a turmoil in a whirl in chaos
in commotion in confusion in disarray
in disguise in disorder in error



in knots in order in other words
in pieces in rebellion in revolt
in ruins in shreds in trouble
in uproar inaccurate incoherent
inconstant incorrect incorrectly
induce infirm ingredients
injure injured inordinately
insane insanely interfered with
intricate involve involved
irregular irregularity irritated

J
jerky jerkily jittery
joggle juggled jumble
jumbled

K
kind kind of kinky
knotted

L
lawless let loose letters of
liquid loosely lousily
lousy ludicrous lunatic

M
mad maddened made
made from made of made up
madly make a bungle of make a hash of
make a mess of make makes
make-up making maladjusted
maladroit malformation malformed
malfunction maltreated maltreatment
manage managed management
manager mangle mangled
manifest manifestation manipulate
manipulated manoeuvre manoeuvred
marred mashed material for
materials for mauled maybe
mayhem meandering medley
melt melted mended
mercurial mess messed
messily messy metamorphosis
mince minced mingled
misapplied misbehaved misconstrued
miserable mishandled mishap
misrepresentation misrepresented misshapen
mistake mistreated misused



mix mixed mixture
mix-up mobile model
modelled modification modified
modify molested mongrel
mould moulded moving
muddied muddle muddled
muddly mutable mutative
mutilated mutilation mutinous
mysterious mysteriously

N
nasty naughty negotiation
negotiated new new fashion
new form of new order new style
newly formed newly made not exactly
not in order not properly not right
not straight novel

O
obscure obscured obscurely
obstreperous occasion odd
odd looking oddly off
operate order ordered
orderly organisation organise
organised original originally
otherwise out outcome of
outed out of out of gear
out of joint out of order out of sorts
outlandish over overthrow
overturn

P
peculiar peculiar looking peculiarly
perfidious perhaps permutation
perplexed perverse perversely
pervert perverted phoney
pie placed plagued
plastic playing tricks poor
poorly positioned possible
possibly potential potentially
preparation prepared problem
problematic problematical processed
processing production properly organised
properly presented pseudo pulverised
put another way put out put right
put straight

Q



queer queered queer-looking
queerly questionable quite different

R
rabid ragged rambling
ran amok ravage ravelled
readjusted rearrange rearranged
rearrangement reassembled rebel
rebellious rebuild rebuilding
rebuilt recalcitrant recast
recollected reconstructed recreate
rectification rectified redesign
redesigned refine refined
reform reformation reformed
refractory regenerate regulated
regulation remade remodel
remodelled rendering rendition
renovated renovation re-order
re-ordered reorganisation reorganise
reorganised repack repair
repaired replaced replacement
represent representation represented by
represented in reproduce reproduced
reproduction resettle resettled
reshape reshaped reshuffle
reshuffled resolution resolve
resolved resort resulting from
resulting in reveal reviewed
revise revised revolting
revolutionary revolutionised revolve
revolved revolving revolution
reword reworded rewrite
rewritten rickety ridiculous
rigged riot rioted
rioting riotous rocky
rotten rough roughly
roving rude ruffled
ruin ruins ruined
ruinous rum rumpled
run amok running amok running wild
ruptured

S
sad sadly scatter
scattered scatters scramble
scrambled scruffy serve up
served up set set differently
set off set out setting



shake shaken shaky
shambles shape shaped
shatter shattered shift
shifted shifting shilly-shally
ship-shape show mutation shuffle
shuffled silly singular
skittish slipping slipshod
sloppy slovenly smash
smashed smashing snarl up
somehow sorry sort
sorted sorted out sort of
sorting source of spinning
split spoil spoiled
spoilt sport sporting
spurious squiggles staggered
stew stewed stir
stirred stirred up storm
stormy straight strange
strange-looking strangely straying
stricken stumbling stupid
stupidly substitute subtle
subvert subverted surprising
surprisingly swap swapped
swapping swirl swirled
swirling switch switches
switched

T
tampered with tangled tattered
temper tempestuous tempestuously
tentative tentatively terrible
terribly the result of throw
thrown tidied up tip
tipped tipsy to pot
topsy-turvy to rights torn
tortuous toss tossed
tousle tousled transform
transformation transformed translate
translated translation transmutation
transmuted transport transported
transposed transposition treacherous
treated trick tricked
tricky trouble troubled
troublesome tumble-down tumbling
tumultuous turbulent turn
turned turned out twist
twisted twister twisting



U
uncertain unclear uncommon
undecided undisciplined undoing
undone uneasy unfamiliar
unhappy unnatural unorthodox
unravelled unreliable unrest
unrestrained unruly unsettled
unsettling unsound unstable
unsteady untidy untie
untied unusual unusually
unwonted upheaval upset
usage use used
uses

V
vacillating vague vaguely
vandalise vandalised variable
varied variety various
variously vary version
version of violent violently
volatile

W
wander wandering warp
warped warring wavering
way way out wayward
weave weird weirdly
well-formed well-ordered well-organised
well-varied went off went to pieces
whirling wild wildly
wobbly woolly work out
works worried woven
wreck wrecked writhing
wrong wrongly

Many thanks to Tom Rayfield for compiling most of this list.



Letter Indicators                  A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z

Letters are often indicated by using words to point to a specific letter in a word, 
e.g. 'capital of France'    for the letter F. Some of these are given below, but most 
of the 'capital of' ones have been omitted since there are so many.

A
absolute temperature about absent
Academician Academy acceleration
accepted ace acre(s)
acreage across acting
active adjective adult
adults only advance(d) advisory
AE African leader afternoon
Alpha alto amateur
American American capital ammeter
ampere(s) Ångström(s) anonymous
answer anterior are(s)
area argon article
atomic atomic weight atto
Australia(n) Austria(n) before
beginning beginning of April beginning of August
bomb ein first
first of April first of August key
middle class middleman midday
middle of May midway note
one per year

B
300 a follower bachelor
bad start barn baron
barrel(s) baryon number bass
basso bay Belgium
Beta Bible bighead
billion bishop black
Blessed blockhead blood group
book born boron
bottle opener bowled Bravo
breadth Britain British
British capital Burmese leader bye
key note second class
second side supporting film

C
100 $100 about
calorie Cambridge canine
can-opener caught by capacitance



Cape carat carbon
castle Catholic caught
Celsius Celtic cent(s)
Centigrade centime century
chapter Charlie circa
cloudy clubs cocaine
cold college college head
Coloured colt common time
Commons' leader compliance Conservative
constant contralto copyright
Corps could start coulomb(s)
Cuba cubic cycle
first course head of clan key
many note number
speed of light

D
500 bad end beginning of December
Danish leader date daughter
day dead death's-head
degree delete Delta
Democrat(ic) denarius density
Department depart(s) depth
deputy head deserted Deus
deuterium Deutsch diameter
diamonds died dimension
dinar diopter Director
directed Dominus duke
dunderhead Dutch first of December
Germany head of department key
large number Lord many
note old penny penny
ring should end U.S. Democrat

E
2.71828... 250 bearing
boat bridge player direction
Earl East eastern
Echo Ecstasy egghead
Egyptian Egyptian leader electron
end of June energy engineer
engineering England English
English leader Epsilon eye opener
final score for bridge 
player

key kind of mail

log base middle of September middlemen
note number oriental
point quarter Spain



sweetheart

F
40 beginning of February fag end
Fahrenheit famous word farad
faraday farthing fast
fathom fellow female
feminine fighter plane figurehead
filly fine first of February
fluorine folio following
foot force foreign
forte franc France
French French capital frequency
Friday function of furlong
key loud loud music
note offend

G
400 £1,000 acceleration
clef dog's tail force
gallon(s) Gamma gauges
Gauss gelding George
German German capital German leader
Germany giga Golf
good Government gram(s)
gramme(s) grand gravity
great Greek leader guilder
guinea(s) Gulf head of Government
inflatable suit key king
legend middle-age midnight
note pig's tail string

H
200 Ache aitch
aspirate beam bomb
end of March end of the month fashion centre
harbour hard headfirst
head of hair head start hearts
height henry henries
her head heroin high
Hindu leader his head hogshead
hospital hot Hotel
hothead hour Hungary
husband hydrant hydrogen
Planck's constant

I
1 a ace



beam current dotted
ego electric current first person
his heart Ich imaginary number
indeed Independence Independent
India Institute International
international leader iodine Iota
island isle isospin
Italy me mid-air
number number one one
personal pronoun second time single
unit

J
beginning of January beginning of June beginning of July
curve first of January first of June
first of July jack James the First
Japan joint joule
Journal Judge Juliet
jump start Justice pen

K
250 1,000 1,024 bits
back end Boltzmann constant cocktail
cork tip Kampuchea kaon
Kappa karat keen beginner
Kelvin kick-start kilo
kilogramme kilometre king
knight knot(s) Köchel
kopeck krona króna
krone kwacha potassium
velocity constant weekend

L
50 beginner central Ireland
coin elevated railway end of April
heart of England inductance inexperienced driver
Labour leader laevorotatory lake
lambert(s) Lambda large
Latin latitude law
leaf league learner
learner driver lecturer left
length letterhead Liberal
Libra Lima line
link lira lire
litre(s) little long
longitude long lead love
low lumen luminance
Luxembourg many mid-Wales



money novice number
port pound pound sign
pupil second class sovereign
tail-end trainee

M
1,000 beginning of March beginning of May
beginning of the 
month

Bond's boss central Denmark

central Germany end of term first of March
first of May Frenchman head of MI5
large number mach maiden
maiden over Majesty male
Malta mare mark(s)
married masculine mass
Master meal starter Mediaeval
medium mega member
meridian meso meta
metre(s) Mike mile(s)
military leader million(s) minute(s)
molar Monday money
monsieur month Moslem leader
mother motorway Mu
noon very many

N
90 and ('n' ) bearing
beginning of 
November

bridge player direction

end of autumn first news first of November
indefinite number mid-evening mid-morning
middle of the month naira name
named Napoleon Nationalist
Navy neuter neutron
new new beginning new head
new leader new start newton(s)
nitrogen nominative noon
Norse North Norway
note noun November
Nu nuclear number
point pole quarter

O
11 beginning of October blob
circle cry duck
exclamation first of October front centre
job centre love middle of October
nil none nothing



nought Ocean octavo
oh Ohio old
Omega Omicron only
Opposition leader orchestra leader order
ordered to start Oscar Oxford
oxygen pint ring
round Scottish pass spangle
sphere Tan zero

P
400 apple-core coin
coppers head of police midshipman
momentum money page
Papa park parking
part participle past
Pastor pawn pedal
pence penny per
peseta peso phosphorus
piano pint parity
party leader pawn pipe
poise political leader population
port Portugal post
power president pressure
Prince pro proton
quiet small change soft
subdued

Q
electric charge first quality head of queue
heat Quaker leader quality
quart quarter quarterly
quartermaster quarto Quebec
Queen Queen's Head Queensland
queer beginning query question
quetzal quick start quintal
quire quran

R
arithmetic electric resistance end of September
end of October end of November end of December
end of war head right king
mid-afternoon middle of March middle of April
monarch never-ending oyster month
queen rabbi radical
radius railhead railway
rand raw beginner reading
rêaumur rebel leader recipe



recto Rector redhead
regiment Regina registered
Republican resistance restricted
reverend revolutionary leader Rex
right ring leader river
road Röntgen Romania
Romeo rook ruble(s)
Roundhead Royal run(s)
rupee Russian leader starboard
summer's end take winter's end
writing yearend year's end

S
7 or 70 bearing beginning of 

September
bender bridge player direction
dollar endless entropy
first of September head of state heart of Essex
ogee Old Bob point
pole quarter Sabbath
safety first saint Santa
Saturday Saxon schilling
school school head second(s)
self-starter September shilling
siemens Sierra Sigma
Signor Sikh leader singular
skinhead small Society
solidus shilling siemens
singular son South
southern spades Square
starboard stokes stop-start
strangeness succeeded sulphur
sun Sunday Sweden
sulphur

T
bone car casual shirt
cat's tail distribution end of August
end product Ford informal shirt
junction kind of shirt kind of square
Middle Eastern rat's tail shirt
square summer shirt surface tension
Tango tare Tau
teaspoonful tee temperature
tempo tenant tenor
tense tera tesla
Thailand Thursday team leader
tesla time ton(s)



tonne(s) Tory leader transitive
tritium troop leader troy
Tuesday Turkish leader

U
acceptable bend bolt
centre court classy done
done thing gent genteel
mid-January posh socially acceptable
sub superior top
top-drawer turn Unicorn
Unionist union leader United
universal University upper class
Upsilon upstart Uruguay
uranium youth centre

V
5 against anti
bomb few mid-Devon
midwives neck number
opposed to opposing see
several sign vanadium
Vatican City velocity ventral
verb verse(d) versus
very Victor victory
victory sign Viscount vol.
volt volume vs

W
bearing bridge player centre forward
cow's tail direction occidental
point quarter raw edge
tungsten Wales watt
wed Wednesday week
weight Welsh Welsh leader
West Whisky white
wicket wide width
wife with winter
wolfram women won
work workers' leader West
western with

X
10 abscissa antepenultimate
buss by Chi
Christ co-ordinate cross
decussate drawn female chromosome
kiss marked choice mark with a kiss



multiplication multiply by mystery man
number over 18 oxtail
ray several sign of the times
spot marker times unknown character
unknown quantity vote wrong

Y
day's end journey's end end of January
end of February end of May end of July
fourth of July male chromosome ordinate
penultimate ponytail unknown quantity
Yankee yard year(s)
yen Yeomanry youth leader
yttrium Yugoslavia

Z
atomic number final final letter
from Zanzibar gauge impedance
last last letter middle-sized
Zaire Zambia Zebra
zenith Zeta Zionist leader
zone




